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ABSTRACT: 

 The technology for developing power factor correction is increasingly being discussed because of 

the increasing number of nonlinear loads that exist. This is related to power quality which can affect load 

system performance because nonlinear loads cause low power factor and the appearance of harmonic 

currents. However, it takes a power factor corrector converter that has a simple construction and reliable 

performance. Interleaved buck Boost Converter is often applied as a power factor corrector converter 

because it has these advantages. Combined with a fuzzy controller it is a proposed system to achieve a 

near unity power factor. The discontinuous Conduction Mode (DCM) technique is used because it has an 

efficient inductor design. The results of the proposed system design were proven by simulation and 

hardware implementation which resulted in significant power factor improvements. 

Keywords: Interleaved buck Boost Converter, Conduction Mode (DCM) & Interleaved buck 

Boost Converter (IBC) 

 

1. INTRODUCTION 

Interleaved buck Boost Converter (IBC) is commonly used for power factor correction (PFC) due 

to its advantages of low current ripple, small filtering volume and high power density, etc. Power-density 

is a key factor that limits application of IBC PFC, where requires small volume and light weight, such as 

on-board charger (OBC), laptop adapter and aircraft power supply. Heat sink, which is used to transfer 

heat generated by power loss to maintain working temperature of devices at the proper range, occupies a 

lot of volume in PFC. Therefore, it is necessary to reduce heat sink volume through increasing efficiency. 

If efficiency can be increased without adding any hardware cost and software cost, then total loss and heat 

can be decreased, heat sink volume can be reduced and power-density of IBC PFC can be increased. Many 
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researchers have been conducted on improving efficiency of PFC by modifying topology to create soft 

switching condition for reducing switching loss.  

2.LITERATURE REVIEW 

A New Current Phasor-Controlled ZVS Twin Half-Bridge High-Frequency Resonant Inverter for 

Induction Heating Tomokazu Mishima (2013): A novel soft-switching high-frequency (HF) resonant 

(HF-R) inverter for induction heating (IH) applications is presented in this paper. By adopting the current 

phasor control of changing a phase shift (PS) angle between two half-bridge inverter units, the IH load 

resonant current can be regulated continuously under the condition of wide range soft-switching 

operations. In addition to this, the dual mode power regulation scheme based PS angle control & 

asymmetrical pulse-width modulation (PWM) in one inverter unit is proposed for improving the efficiency 

in low output power settings. The essential performances on the output power regulation and soft-

switching operations are demonstrated in an experiment using its 1kW- 60 kHz HF-R inverter prototype, 

then the topological validity is evaluated from a practical point of view. 

 

 High Power Density Series Resonant Inverter using an Auxiliary Switched Capacitor Cell for 

Induction Heating Applications 

Bishwajit Saha, Rae-Young Kim (2013)- This project proposes a unique topology of voltage fed high 

frequency series load resonant inverter with a lossless snubber capacitor and an auxiliary switched cell for 

induction heating appliances. The main objective of this paper is to demonstrate how high power density 

can be achieved by including a switched capacitor cell with the capacitor-clamped half-bridge ZVS high 

frequency inverter circuit using the PWM control scheme. The operation principle of the proposed inverter 

circuit is based upon an asymmetrical duty cycle PWM control scheme. The operating performances of 

high frequency AC regulation and power conversion efficiency characteristics are shown through 

experiments with their soft-switching operating ranges. 

 

PV STRING PER-MODULE MAXIMUM POWER POINT ENABLING CONVERTERS 

G.R. Walker (2011): Many grid connected PV installations consist of a single series string of PV 

modules and a single DCAC inverter. This efficiency of this topology can be enhanced with additional 

low power, low cost per panel converter modules. Most current flows directly in the series string which 

ensures high efficiency. However parallel Cuk or buck-boost DC-DC converters connected across each 

adjacent pair of modules now support any desired current difference between series connected PV 

modules. Each converter “shuffles” the desired difference in PV module currents between two modules 

and so on up the string. Spice simulations show that even with poor efficiency, these modules can make a 

significant improvement to the overall power which can be recovered from partially shaded PV strings. 

 

3. EXISTING SYSTEM 

 The existing converter consists of a full-bridge diode rectifier, an isolated resonant dc–dc 

converter, and only one controller. The existing converter provides the PWM technique for all 

components operating at low frequency, allowing for an improvement in power density without a cost of 

power-conversion. Furthermore, by using a controls power factor and output power, the converter 

performs ac–dc power conversion in only a single-power processing step.  
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4. EXISTING BLOCK DIAGRAM 

 

 

5.PROPOSED SYSTEM 

  The development of new families of Interleaved Buck Boost Converter topologies used in the 

design of dc–dc converters with active power factor corrections (PFC’s). The goal is to design high-

efficiency and high-power density converters with improved power factor and low electromagnetic 

interference. In recent years, as the new standards became compulsory regarding limiting the total 

harmonic distortion and input power factor in power electronic circuits. Active PFC circuits that use pulse 

width modulation (PWM) switch-mode topologies such as the boost, buck–boost, and their derived ones 

have been used dominantly. 

 

5.1. BLOCK DIAGRAM OF PROPOSED SYSTEM 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. RESULT AND DESCUSION 

6.1 SOFTWARE SIMULATOR 

MATLAB 

        MATLAB is a high-performance language for technical computing. It integrates computation, 

visualization, and programming in an easy-to-use environment where problems and solutions are 

expressed in familiar mathematical notation.  

Typical uses include:  

Math and computation  

Algorithm development  

Modeling, simulation, and prototyping  
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Data analysis, exploration, and visualization  

Scientific and engineering graphics  

Application development, including Graphical User Interface building  

MATLAB is an interactive system whose basic data element is an array that does not require 

dimensioning. This allows you to solve many technical computing problems, especially those with matrix 

and vector formulations, in a fraction of the time it would take to write a program in a scalar non-

interactive language such as C or FORTRAN. 

 

Modeling and Simulation 

Matlab has several auxiliary Toolboxes distributed by Math works, Inc., which are useful in 

constructing models and simulating dynamical systems. These include the System Identification Toolbox, 

the Optimization Toolbox, and the Control System Toolbox. These toolboxes are collections of m-files 

that have been developed for specialized applications. There is also a specialized application, Simulink, 

which is useful in modular construction and real time simulation of dynamical systems. 

 

System Identification 

 The System Identification Toolbox contains many features for processing experimental data and is 

used for testing the appropriateness of various models by optimizing values of model parameters. It is 

particularly useful in working with dynamical systems data and time series analyses. This toolbox is 

included in the Matlab installations on all the ITS servers. The identification process is a bit complex, but 

a guided tour through a simple example can be accessed with the iddemo command at a Command 

Window prompt. 

 

Using Simulink 

 Simulink is a simulation tools library for dynamical systems. Any system in nature can roughly be 

thought of as a “black box” receiving an input vector u and eliciting a unique output vector y. In the case 

that both u and y vary with time we are talking about dynamic systems. 

 

Associated with a system is the so-called state vector which loosely speaking contains the required 

information at time that together with knowledge of the input for time greater than, uniquely determines 

the output for. A general continuous dynamical system can be modeled by using the following set of 

ordinary differential and algebraic equations. 

 

Simulink Library Browser: 

 Simulink can be launched by typing 

>> Simulink 

in the Simulink icon in the Command window of the default Matlab desktop. 
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The library’s functionalities are divided into eight groups (click on any of the category icons for 

both the UNIX or Windows versions). For example, the categories Sources and Sinks contain various 

kinds of inputs and ways to handle or display the output respectively. Also, it contains the group 

Continuous that will be used later deals with dynamical systems. 
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Simulink Subsystems 

In Matlab programming, functions are used to encapsulate a computation so that it can be used 

repeatedly without having to duplicate code wherever it is needed. In addition, a function can insulate its 

calling script from having to worry about its implementation details. In Simulink, subsystems play a 

similar role. Using subsystems in Simulink has these advantages: 

It helps reduce the number of blocks displayed in the model window. 

Functionally related blocks can be kept together. 

It permits the establishment of a hierarchical block diagram, wherein   a    Subsystem block is on 

one layer and the blocks that make up that subsystem are on another. 

In Simulink, a subsystem can be created in two ways: 

One way is to add the blocks that make up the subsystem to the model, then group those blocks 

into a subsystem. 

The other way is to first add a Subsystem block to the model, then   open that block and install the 

component blocks of the Subsystem to the subsystem window. 

 

Grouping existing blocks into a Subsystem 

 If a model already contains the blocks needed for a desired subsystem, you can create the 

subsystem by grouping those blocks: 

 Enclose the blocks and connecting lines that you want to include in the subsystem within a 

bounding box. For example, the figure below shows a model that does signal processing. The Abs, Sine 

Wave Function and Add blocks that do the signal conversions are selected within a bounding box. The 

box illustrated can be selected by clicking the mouse at the upper left position, and then while depressing 

the right mouse button drag to the lower right position. 

 
The components within the box will be selected when the mouse button is released. Choose Create 

Subsystem from the Edit menu. Simulink replaces the selected blocks with a Subsystem block. The figure 

below shows the model after the Create Subsystem command has been chosen. If necessary, the 

Subsystem block can be resized so that the port labels are readable). 

 
Creating a Subsystem by adding a Subsystem block 

  The process of creating a subsystem before adding its component blocks usually consists of three 

major steps: 

1. Copy the Subsystem block from the Ports & Subsystems library into your model. 

2 Open the Subsystem block by double-clicking it. Simulink opens the subsystem in the current or a new 

model window, depending on the model window reuse mode that you selected. 

3. In the empty Subsystem window, create the subsystem. Use Inport blocks to represent input from 

outside the subsystem and Outport blocks to represent external output. 
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Here is an example which models an integrator system. 

1. From the Simulink Library Browser, go to the Ports & Subsystems subdirectory. 

    Click-drag the Atomic Subsystem block into the Model window. 

2. Open the subsystem block by double-clicking the subsystem block. 

3. Delete the line connecting In1 block and Out1 block. 

4. Insert blocks into this subsystem window as prescribed in the figure below and 

    then fix the block layout and connections between blocks. 

 
5. Click on the Go to parent system button or choose View > Go to the Parent from the navigation bar. 

This will send you back to the underlying Model window. 

6. Go back to the Simulink Library Browser and add sine wave function and scope blocks into the Model 

window as described below. 

 
7. Run the simulation by clicking the Start button on the toolbar or by selecting   Simulation > Start from 

the navigation bar. Results can be seen by double clicking on the scope block.           

 

7. SIMULATION DIAGRAM 
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8. SIMULATION RESULT 

8.1 INPUT VOLTAGE AND CURRENT 

 

 

8.2 OUTPUT VOLTAGE AND CURRENT: 

 

9. CONCLUSION 

To improve the power factor under the light load, we propose a duty-ratio feed-forward controller 

for the Interleaved Buck Boost PFC converter. The interleaved PFC converter features step-up/down 

ability, low cost, and high efficiency. However, it suffers from low power factor and total harmonic 

distortion under the light load due to the input capacitor effect. The proposed feed-forward controller aims 

at compensating the phase leaded current caused by the input capacitor. We describe the implementation 

of the controller, the required compensated current, and the controller structure in detail. We conducted 
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experiments with a prototype to verify the operation of the proposed feed-forward controller. The 

proposed feed forward controller significantly increased the power factor of the converter. Meanwhile, the 

output voltage of the PFC converter is well regulated. 
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